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The following icons are used in this user manual:

The information icon precedes important information.

& | Theexample icon indicates a practical illustration of a process or procedure.

The hint icon indicates a suggestion or hint to guide or assist you with performing a
task.

v | The warning icon precedesa warning against potential mistakes and actions that could
~ | cause critical error.
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Congratulations on choosing Attix5 Pro Server Edition. Attix5 Pro minimises risk, maximises
productivity and allows businesses to regain control of their most valuable asset - their data.

For technical support, pleasego to Help > About Attix5 Pro SE , and then use the contact
details provided.

With Attix5 Pro Server Edition (SE), data stored on servers and databases can be backed up to a
Storage Platform quickly, securely and automatically.

The following diagram illustrates the
Storage Platform scenario:

Files and folders stored on one or more
servers running SE can be backed up to
a Storage Platform . In the event of data
loss or corruption on the server, you
can retrieve data from the Storage
Platform and restore it to the original

or another server in just a few easy

steps.

A Backup Administrator can manage the entire backup environment (Backup Clients and the
Storage Platform) remotely, using the Attix5 Pro Storage Platform Console For more
information, please refer to the Attix5 Pro Storage Platform Console User Manual
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1. Getting started

Enabling manual or automatic backups is easy with Attix5 Pro Server Edition:

BACK UP
Automaticallyor
manually

Create a Backup Select files and
g stall SE Account folders for backup

(See page 16) (See page 41) (See pages 5153)

(See page 7)

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved. n
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Below are the systemrequirements for Attix5 Pro Server Edition.

g} Note: For the latest system requirements and compatibility information, please refer to
the Requirements-Compatibility.pdf (provided with each release of the Attix5 Pro
software).

System requirements

Operating System
SEis available for the following Microsoft operating systems:

Windows Server 2008 (Incl. Small Business Server bundlesand R2)
Windows Server 2003 (Incl. Small Business Server bundlesand R2)

Processor & Memory

Recommendation table

Less than 200 GB Pentium 4, Entry level 1GB

200 GB- 500 GB Pentium 4, 2.0 GHz 1GB

500GB-1TB Dual Xeon, 3 GHz+ 2 GB
Disk Space

Required :50 MB plus space for localcache

.

4

Note: Please ensure thatthe drive on which the Backup Client will be installed has
enough free space to storecopies of the selected files.

Recommended: Amount of free space equal to the Backup Account limit if Binary
Patching is enabled. The space requirement for Delta Blockingis considerably less. For
more information, see Patching in Chapter5, A Backups. 0

=

Example : To back up 10 GB of data, at least 10 GB of available free spaceis
required on the drive containing the working folders .

g/ Note: Plug-ins may also require additional working space. For more

information, please refer to the applicable plug -in documentation.

StorageServer : The local cachecan be as large as the total size of all filesncluded in
the backup selection.

= | Example : A 10 GBinclusion may require up to 10 GB free space for the cache.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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Database (using Database plug -in) : Space isrequired for the data dump (which
can be as large as the databageand as well the cache(which is the compressed version
of the databasé. Assuming 1:2 compression on a 10GB database you are recommended
to have 15GB (10 GB for the dump and 5 GB for the cache) free space available.
Temporary working space is also required for subsequentbackups; the requirement will
be less than 5GB in the above-mentioned example.

Minimum video requirements: 800 x 600 Resolution, 256 colours
Virtual memory: Double the amount of RAM, with a minimum of 512 MB (Total for

all disk volumes)
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The SE MSI file contains pre -configured information to make installing SE quick and easy. For
more information on creating MSI files and launching them from the Run Command, please
refer to the Attix5 Pro Storage P latform Console User Manual

i The options available during the installation process depend on the settings
enabled by the administrator when the MSI file was created. These options range from
advanced install settings to specifying the install location. The default install path is:
C:\ Program Files  \ Attix5 Pro SE

v, | Pre-installation  warning s:

A If running antivirus software , please ensure that all Attix5 Pro folders are excluded
from antivirus scans to avoid data corruption.

A Both antivirus software scans and backup processes are resourceintensive. It is
advised not to run a backup and virus scan at the same time as this will
significantly decrease machine performance.

A Windows will check whether you are running the MSI file suited to the installed
operating system (i.e. 32-bit or 64 -bit) and will not allow you to install the wrong
version.

To install Attix5 Pro SE:

1. Run the MSI file.
2. Inthe Attix5 Pro SE Setup Wizard that appears, follow the steps as described below.
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The Attix5 Pro SE Setup Wizard typically consists of five stepsto guide you through the Setup
task in a simple, step-by-step manner. These steps also make itpossible to undo previous
operations by navigating backward.

Some of the settings described below may have been removed when the MSI was
created. Furthermore, the wizard may contain additional step s. Please read each
window carefully before continuing.

If you receive a Windows User Account Control message, asking you if you wish to
allow the Attix5 Pro program to make changes to the computer, click Yes to
proceed.
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To start the Setup Wizard: ) s Pro SE Setup =l = )

Click Next . Welcame to the AttixS Pro SE Setup
Wizard

The Setup Wizard will install AttixS Pro SE on your computer,
Click Mext to continue or Cancel to exit the Setup ‘Wwizard,

ATTIX’Pro

Back.

Cancel
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To enable the Backup Clientto read all files that must be backed up, it may be necessary for the
Backup Client service to run under a specific Windows account.

To specify which Windows account
should run the backup service

SelectRun as LocalSystem
Alternatively, specify a specific
Windows user account:

1. Select Run under this
user account

2. In the User Name box,
type the Windows user
name for the account.

3. In the Password box,
type the Windows user
account password.

4. Click the Validate button.

5 At Pra SE Setup

Service User Account

Mormally the backup service runs under the LocalSystem account, but that ( @

can be changed here.

1@ Run as LocalSystem
Run under this user account:

User Mame:

£.0. DomainiUser

Passward:

alidate

===

Back |[ hext ] ‘ Cancel

5. Once the Windows user account has been validated, clickNext .

v | Warning:  Please ensure that the user account specified in this step has full access to
all files to be backed up. If files are included for backup that the account does not have

access to, a @ Some

the backup logs.

files were

skippedo
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To specify a destination for the SE
application files and folders:

Click Next to accept the default
destination folder and continue to
the next wizard step.
Alternatively, specify a new
destination folder:

1. Click the Change button.

2. Browse to the folder.

3. Click OK.

4. Click Next to continue to

the next wizard step.

= e =

Destination Folder @
Click Mext to install ko the default Folder or click Change to choose another, L |

‘_‘@ Attix3 Pro SE Setup

Install AbtixS Pro SE ko

|C:lProgram Files\attixs ProtBackup Client SEY

change. ..

Back. “ Mext ] l Cancel




Once all the settings are configured, the wizard is ready to begin the installation.

To begin the SE installation
Click Install

ATTIX’

2] At Pro SE Setup ol o =

Ready to install Attix5 Pro SE

Click Install ta begin the installation. Click Back ko review ar change any of your
installation settings, Click Cancel to exit the wizard,

e

Back |[ A Install ] |

Cancel
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The last step of the wizard presents the 180 Attics Pro SE Setup =) = s
option to launch the Backup Client. .

Completed the AttixS Pro SE Setup

Wizard
TO |aunCh the BaCkup C|Ie|’]t Click the Finish button to exit the Setup Wizard,
immediately after the Setup
Wizard:

1. Ensure that the Launch Backup
Client SE check boxis selected.
2. Click Finish .

/| Launch Backup Client SE

ATTIX®Pro

Back Cancel

If the MSI file is being run from the same location as the plug -in installer file, the
Setup Wizard will give you the option to launch the plug-in installer before
launching the Client. Select the Launch Plug -in Installer  check box to run it
immediately after the Attix5 Pro SE Setup Wizard. For more information about
plug-ins, please refer to the Attix5 Pro Server Edi tion Plug -ins user manual .

Before the Plug-in Installer launches, a User Account Control dialog box may
appear, asking you if you wish to allow the Plug -in Installer to make changes to
the computer. Click Yes to run the installer .

If you selected the Launch Backup Client SE check box in the last step of the Attix5 Pro SE
Setup Wizard, the Backup Client will open automatically upon clicking Finish and the Backup
Account Setup Wizard will launch, enabling you to create a Backup Account. Follow the
wizard steps as described n Chapter 3, AAccount setup. O

If you opted not to launch the Backup Client immediately, you can open the Client interface at a
later stage via the Start menu or by following any of the instructions listed under Opening the
Backup Client in Chapter 4, iGraphical User I nterface

i) The Account Setup Wizard will launch when you open the Backup Client for the
firsttme. See AAccount Setupo bel ow.
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To backup or restore data using the Backup Client, a Backup Accountis required.

If you selectedthe Launch Backup Client SE check box in the last step of the Attix5 Pro SE

Setup Wizard (see The Attix5 Pro SE Setup Wizard in Chapter 2, fil nst)athelBackupo n o
Client will run and display the Backup Account Wizard automatically. Use this wizard to set up a
Backup Account by following the steps as described below.

If the Launch Backup Client SE check box was not selected in the last step of theéSE Setup

Wizard, the Account Setup Wizard will launch when the Backup Client is opened for the first

time (for more information, see Opening the Backup Clienti n Chapt er 4, AGraphic
Interfaceo ) .

i) To run the Account Setup Wizard at any other time : On the Tools menu, click
Account Setup Wizard . In the warning box that appears, click the Run Account
Setup Wizard  button and follow the instructions below from Step 2 (below) onwards .
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The Account Setup Wizard typically consists of eight stepsto guide you through the Setup task
in a simple, step-by-step manner. These steps also make it possible to undo previous operations
by navigating backward.

i) Some of the settings encountered in the wizard may have been removed when the
MSI was created. Furthermore, the wizard may contain additi onal steps. Please read
eachwindow carefully before continuing.

i) This step displays when the wizard is run directly after the SE Client installation.
If accessing the wizard at a later stage ( via the Tools menu), this step will not display as
the Storage Platform settings will already have been configured.

To specify the Storage Platform Bl pecounsSeup i o %
connection settings 1%

Please contact your backup administrator I you do not have the required information.

Storage Platform Settings

1. In the Storage Platform
address box, type the IP address
or DNS name of the Storage
Platform where the Backup
Account resides.

2. Inthe Group name field, specify
which Backup Group the Account

m address: |192,168,20.215

A-5P OWNERIRESELLER AlBACKUP ACCOUNTS

ATTIX’Pro
belongs to. [ ] e e
i) Type the Group &
| name in relation to COLLECTIONA COLLECTIONB GROUP
any Collections it may
belong to.

3. In the Group create key field, specify the preconfigured Group create key for the
applicable Group. If you do not have access to this key,please contact your Storage
Platform administrator.

i) This key is case sensitive.

4. Once all the correct settings have been entered, lick Next .
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This wizard step is typically the first to be displayed if you access the wizard via

the Tools menu.

You can selectl want to connect to an existing Backup Account to:
Connect to an Account that has been openedfor use by this computer.
Reconnect to an Account to recover data from the computer that had
previously backed up to this Account.

To create a new Backup Account

1. Select| want to create a new
Backup Account
2. Click Next .

To connect to an existing account:

1. Selectl want to connect to an
existing Backup Account

/| Warning:  Different
servers cannot back up to

A separate Backup Account
needs to be created for each
server.

2. Click Next to continue.

[E] &ccount Setup Wizard

Specify the account type.
Chaose between a new or existing Backup Account, Vou cannet connect ta the same Backup Account from

different machines.
Accourt Type:

Flease select one of the Following:
@ Twant b craats & riew Backlp Accolrt s

Twant: b connect to an existing Backup Account:

ATTCPro

==
e

Help < Back. Mext =

][ gancel

the same Backup Account.
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Depending on the option you selected in the previous step, you will either be prompted to
specify new Account details or to supply

the already configured details of the [ — =
. . Enter the new account details. @
existing Account. P —— L
Account Details
Backup Accourt name: BACKUP ACCOUNT 01
. . Account password:  eessss
To specify new Account details: i e
Confirm password: | esssss
1. In the Backup Account name TL"SES52?.”2152:‘2?%55?&2123Sl‘i’ifiiiféé”ﬁé.‘iilafeﬁi‘.lffy”.fif‘i:.”2?&.121’:;’&'2“23f"
store it somewhere safe,
box, type an Account name that Bl (seeseess
Mirirnum & characters
consists of a minimum of 4 @ialm |
characters.
2. In the Account password box, s
i ATTIX Pro
type a password that consists of a | ] L]

minimum of 4 characters.
3. In the Confirm password box,
repeat the Account password entered in the Account password  box above.
4. In the Encryption key  box, type an encryption key that consists of a minimum of 8
characters.
/% | Warning : Disaster recovery is not possible without the encryption key. Please
ensure that this key is kept in a safe place. THE ENCRYPTION KEY IS NOT

STORED ON THE STORAGE PLATFORM AND CANNOT BE RECOVERED OF
RESETIF LOST.

5. Click Next .
When connecting to an existing (3 s i %
Enter the new account details,
A C CO u nt «Choose and enter your preferred account name, password and encryphion key., [ L,—‘;
‘Account Details
1. In the Backup Account name i ot vne ekt accom ol
box, type the Account name.

Hinimum & char acters

2. In the Account password box,
type the Account password.

3. In the Encryption key  box, type
the encryption key chosen when

the Backup Accountwas created. R oo

Help. H < Back |[ Hext > H Cancel




To specify the connection settings

1. In the Connection Settings area,
select | use broadband or
another permanent network
connection

2. If a proxy server will be used:

2.1. Click the Configure

Proxy button.

In the Proxy Setup dialog

box that appears, select a

proxy type.

If Use SOCKSV5 Proxy or

Use HTTP Proxy

2.2.

2.3.

24,

ATTIX’

[Edl 2ccount Setup \izard
What kind of connection do you have?
Select the type of connection that you Use ko connect ko the Internet. t
Connection Settings

%) 1 use a modem/diakup connection.

@ {3 bioadband of anSther pefmanent nebwor: connectior

Configure Proxy

ATTI?Dro

N

g | [ <Back [ Het> ][ Ca

ncel

is selected, fill in the Proxy Host
If login details are required, select the Proxy server requires authentication

and Proxy Port  boxes.

check box andtype the username and passwordin the boxes provided.
2.5. Click OK to close theProxy Setup dialog box.
3. Click Next to move to the next step in the wizard.
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Attix5 Pro can run backups on included files and folders either upon request (manually) or
automatically. This step enables you to set up a backup schedule.

To configure the Backup Client to EES
run only manual backups:

1.

It is advised to back up at e —— =
night when the server is ru.nning Tty o b v o s e s st UL@
and the Backup Client is not in use. N
The server must be switched on at i :
the time(s) specified for scheduled sk evrydoy o = 390 | @)
backups, but the Windows user ettt
does not need to be Iogged |n ‘Week Day Additional Schedule
Monday
ieascey

Thursday 2ad
Friday

Backup time:
= zhoo | @D

Sunday

ATTIX®Dro

Clear the Daily automatic
backups check box

Hep | [ <Back | [ mest> | [ Cancel

Click Next to move to the next
step in the wizard.

Warning:  This option is not recommended. If an automated backup scheduleis not
created, backups will have to be run manually . Enabling automatic backups is
strongly advised .

To schedule daily automatic backups

Select theD aily automatic backups check box

In the Back up every day at  box, specify a backup time.

Click Next to move to the next step in the wizard or schedule additional advanced
backups as described below.

To schedule advanced backups:

o wn

Selectthe Advanced Schedule check box.

In the Week Dayarea, selecta day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule box.
Repeat the steps above until you have added al desired schedules to theAdditional
Schedule box.

Click Next to move to the next step in the wizard.



Under normal circumstances, the default
Temp , Cache, Logs and Database

folder locations can be accepted andyou
can click Next without making any
modifications. If, however, the drive on
which the Backup Client is installed has
limited space available, you can move the
folders and selection databaseto another
location.

r. | Warning: Please ensure that
these folders are located on a
drive with sufficient free space.

ATTIX’

[B] 2ccount Setup Wizard (=)
Do you want to modify the default working folders?
‘tau can move the Cache, Lag, Temporary folders and the Selection Database to anather location if there is @
limted space vailable on the drive where the Backup Clint s installed. =
Working Folders
ote: Alays keep thess fokders on the same drivefvolume. TF the Cache: and Temp Folders are place...
Temp: C:\Program Filesiattics ProfBackup Client SE\toBackup Brawse.
Cache: :\Program FilesAttixS ProjBackup Client SEYcache Browse. ..
Logs: :\Program FilesyAttixS ProyBackup Client SEYlogs Browse. ..
Database: C:{Program Files\AttixS ProjBackup Client € Browse. .
ATTRCGPro
telp | [ <Back | [Hexts F [ Cancel

To change the temp , cache , logs and/or database

folder

locations:

1. Click the Browse button next to the appropriate box (e.g. Temp ), and then select a

different location for that folder.

2. Repeat step 1 above until all folder locations are correctly specified.
3. Click Next to continue with the installation process.

v | Warning: The Cache and Temp folders must reside on the same drive/volume.
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Attix5 Pro V6 installs with Email
notification and System gate plug-ins by H [L@
default. In this step, you can configure

these plug-ins or accept their default
configuration and proceed to the next step

in the wizard.

To configure a plug  -in:

1. In the Configurable plug-ins list, A
i . ATTIX Pro
click the plug-in name. o || e | [E | o
2. Click the Configure button.
3. Configure the settings as required.
(For more information on config-unadidn options,
4. Click OK to close the dialog box and return to the wizard.
5. Click Next to continue to the next step in the wizard.




In the final step of the Account Setup
Wizard, a Summary screen displays a list
of the configured settings.

To confirm the Setup information:

1.

3.

Read and wverify that the
information is correct, and then
click Next .

The Backup Client will connect to
the  Storage  Platform  and
configure the Backup Account. A
message will be displayed to
confirm that the Account was set
up successfully.

Click Ok to close the message box.

The Setup Wizard Completed screen will
confirm the Account creation /connection .

Now that a Backup Account has been
configured/you have connected to an
Account on the Storage Platform, you can
select the files and folders you wish to
back up.

ATTIX’

[Ed] &:ccount Setup Wizard

Confirm your account settings.

1F the settings below are correct then dick Next, otherwise click Back to change your settings.

Summary

You have entered the Fallowing information:

ALtiXS Pro 5 Username: BACKUP ACCOUNT 01
Cormection method: — Local Area Network
Automatic backups:

Backup daiy at: 19h00

ATTIX®Pro

e

pelp | [ <Back | [ Hext >

[ o

[Ed] Account Setup Wizard

Setup Wizard Completed
The next step is bo configure the backup selection list, You can include files, folders and use selection filers,
Refer to the Backup Clent Help section for
further information.

=

£

“four account has been created successfully.

Group: A-SP OWNERVRESELLER AVBACKUP ACCOUNTS
Username: BACKUP ACCOUNT 01

Account size: 1024 MEB

“fou may now proceed to select files and folders for backup

ATTIN®Pro
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You can use the Graphical User Interface (GUI) to:

Select files for backup

Launch backups

Schedule automatic backups

Find files in previous backups

Restore files and folders from previous backups



Opening the Backup Client interface

To open the SE Client interface

On the Start menu, point to All Programs

Client SE.

‘ @ Default Pragrams
WY Desktop Gadget Gallery
& Internet Explorer
) Windaws DVD Maker
B2 Windows Fax and Scan
 vindows Media Center
@ Windows Media Player
E'_| Windows Update
A ¥PE Viewer
L. Accessories
L. AtixS Pro

Bl Backup Client/SE

L. Storage Platforin
. Games
, Maintenance
 Microsoft Office
| Startup

Al Prograrns

| Search progrars and files

, point to Attix5 Pro

User ¥
Documents
Pictures
Fusic
Garres
Cornputer

Contral Panel

Dewvices and Printers

Default Pragrams
Help and Support

Wfind o

, and then click Backup

ATTIX’
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Alternatively, if the Client interface is closed but the service isstill running (if the 5 icon displays
in the system tray), double-click the Attix5 Pro icon or right -click it, and then click Open :

Open

Backup Moy
Cancel Backup
Monitor Status

Maotifications »
Abhout

i) | Note: The firsttime you open the Backup Client, the Account SetupWizard launches

automatically . For more information on creating a Backup Account,seeChapt er 3,
setup. o

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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The Client interface  explained

You can manage and monitor backups using the Backup Clientapplication window, the system
tray icon or the notification bubbles that appear when certain processes occur. Below are
descriptions of each of these items and the options they provide.

Application window

The Backup Client application window contains the following areas:

[Ed] Attix5 Pro SE VDD (E=H EcR (x|

Fle Selection Tools Help
@ @ : & Product Help
Options Automate | Help A’

-
@ fa ¥
LV 9@
Backup  Se Restore  Find
& Backup Selection | | Restare | =] Logs|
T == R L= |
=

Menu bar

Toolbar

B3 L §Recyde.Bin 2009-11-12 12:18:27
Recycle Bin L= Config.Msi 2010-01-15 09:35:08 Quick-start / Tabs
CDHHQ‘M;I L= M50Cache 2009-11-12 12:35:01 Step-by-step quide 1
- M50Cache L= Perflogs 2009-07-14 04:37:05
 PerfLogs L Program Files Z010-01-16 18:45:06 g;;z";’;""w to.
- Program Files L= ProgramData 2009-11-20 10:05:44 Use selection ket / PrOdUCt Help
— ProgramData L= Recovery 2009-11-12 12:17:55 |
' Recovery L= System Volume Information 2010-01-18 10:07:30
- System Yolume Inf | | Users

— Users ~ Windows
= windows autoexec.bat

3 l;. Restores: How to...
1 Svstem State Plugin || ©  config.sys
-
-

Restore files and Folders
Find particular files to restare
Restore the backup selection

art
e manually
20081112 12; | schedule sutomstic backups
s |_— Status bar

-

\i

hiberfil.svs
pagefile sys

1,965,736 KB 1970-01-01 i
2,620,984 KB 1970-01-01 02:00:00

Options and settings
Account and securit
Connections

Disk usage.
Performance and limits

Global filters
Patching
Mandatory pakching
Logaing

Advanced options

Additional information

Resuming backups
Hotifications

Server Edition auto-updates
Concurrent backup processing
Adding network volumes
Remote Management:

< i / Wultiple Bachup Sets
L ! Health Check

Qutlook PST files -

Ready
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Menu bar and toolbar buttons

All Backup Client functions can be performed from the menu bar. Shortcuts to the most
commonly used menu bar functions are also available on the toolbar and right -click menus.

Menu bar

Each menu on the menu bar contains one or more options. The tables below describe the
options available.

File menu

Backup Initiate a Backup immediately. @
N ow _

Backup
Restore Switch to the Restore view in the Client.

Q Tip: For faster access to the Restore view, click ;t.: ;
the Restore tab instead of using the File menu. Restore

Calculate Determine the total size of the dataincluded in the backup Y‘-@

Size selection. For more information, see Determining the
. o ~ Si
backup selectionsizei n Chapter 5, HfABacl e
Find Access theFind Files in Backups  dialog box. This box g
Files in enables you to search for particular files in your backups. For r@
Backups more information, see Finding files in backups in Chapter 6, Find
ARestores. 0
Export Export a list of all backup inclusions and exclusions to an Selection Tools Help
Selection html file for future reference. For more information, see Backup Mow
Exporting a selection report Restore

Calculate Size

Find Files in Backups
Export Selection

Exit
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File menu continued...

ATTIX’

Exit

Close theBackup Client application window.

\,> Tip: You can re-open the Client window at any
time via the Windows Start menu or by double-

clicking the icon in the system tray.

Selection menu

Filters >

New Filter

Filters >
Edit
Filters

Create a new
filter to
automate
inclusions or
exclusions
based on file
type. For more
information,
seeUsing
filters in
Chapter 5,
fiBackups

Edit existing
filters. For

more
information,
seeUsing

filters in
Chapter 5,
fiBackups

ISeIectin:nn Taols Help

Filters Mew Filker ...
Include Folder Edit Filters ...
Exclude Faold
s Folder 1 Graphics 2
Deselect Folder ) MS Access databases »
Refresh 1 M3 Office dacuments  »
SIrEs F3 T M3 Qutlook email »
1 Web pages 2
ISeIectin:nn Taols Help
Filters 3 Mew Filker ...
Include Folder Edit Filters ...
Exclude Faold
HELEE Foider 1 Graphics b
Deselect Folder ) MS Access databases »
Refresh 1 M3 Office dacuments  »
SIrEs F3 T M3 Qutlook email »
1 Web pages 2
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Selection menu continued...

Filters >
[filter ] >
Include

Filters >
[filter ] >
Exclude

Filters >
[filter ] >
Deselect

Include all files
in the selected
folder that
match the

f i Istriteriad
For more
information,
seeUsing
filters in
Chapter 5,
fiBackups

Exclude all
files in the
selected folder
that match the
f i Istrieeriad
For more
information,
seeUsing
filters in
Chapter 5,
fiBackups

Clear the
selected folder
of any filters
currently
applied to it.
For more
information,
seeUsing
filters in
Chapter 5,
fiBackups

!Selectiun Tools Help

Filters e Filter ...
Include Folder Edit Filters ...
alr,
Exclude Fold =
ees Teaer ) faraphics 4 Include
Deselect Folder '
) M3 Access databases » Exclude
Rafresh 1 M3 Office documents  » Deselact
Bires F 1 M3 Qutlook, email 3 FREEE
T Web pages 3
ISelectiDn Tools Help
Filkers 3 Mew Filker ...
Include Folder Edit Filters ...
Helr,
Exclude Fald g
rece Fower T draphics » Include
Deselect Folder \
1 M3 Access dakabases » Exclude
e T M3 Office documents  # o
SITEs £ 1 M3 Qutlook email 2 FEEIEE
1 Web pages 3
ISeIectiDn Tools Help
Filters 3 e Filter ...
Include Folder Edit Filters ...
alr,
Exclude Falder . e
i dGraphics P v Include
Deselect Folder '
1 M3 Access dakabases » Exclude
Rafresh 1 M3 Office documents  » ——
Bires P 1 M3 Qutlaak, ermail 3 ESEIeE
T Web pages »
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Selection menu continued...

Include
Folder

Exclude
Folder

Deselect
Folder

Refresh

Include the selected folder for backup.

Exclude the selected folder from the backup selection.

Clear the selected folder of any inclusions or exclusions.

Refresh the selection being displayed.

ISelectiDn Tools Help

Filkers
Include Falder
Exchude Faolder

Deselect Folder

Refresh

F5

ISelectiDn Tools Help

Filkers
Include Falder
Exchude Faolder

Deselect Folder

Refresh

F5

ISelectiDn Tools Help

Filters
Include Falder
Exclude Faolder

Deselect Folder

Refresh

F5

ISelectiDn Tools Help

Filters
Include Falder
Exclude Faolder

Deselect Folder

Refresh

F5
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Tools menu

Add Add a network volume. For more m Help

Network information, see Add network Add Metwork Yolurme

Volume volumeinChapter 8, AO Additional Backup Sets »
settings.o fukomatic Backups

Account Sektup Wizard

Rermoke Management

Health Check. ..

Snapshiak 3

Flug-ins 3

Opkions
Additional Create additional backup sets. This m Help
Backup Sets enablesyou to have separate backup Add Mebwork Wolume M_[
> Add selections that you can recoveras Additional Backup Sets » Add

Account Setup Wizard
SetsnChapter 8, fAOpt

settings.o

Additional Access the Backup Schedulgagein [T':":'ls Help
Backup Sets the Options and Settings  dialog Add Metwork Yolume

separatesets of files. For more Automatic Backups Manage
information, see Multiple Backup

> Manage box. Using the settings in this dialog Additional Backup Sets » Add

box, you can manage the schedule(s) Automatic Backups Manage

of your backup sets.For more Account Setup Wizard

information, see Multiple Backup
Setsin Chapter 8,i Opt i ons a

settings. 0

Automatic Access the Backup Schedule settings [Toals | Help

Backups in the Options and Settings  dialog Add Mebwork Wolume
box. Configure the settings in the Additional Backup Sets »
Automatic Backups area to set up one Aukaratic Backups

or more automatic backups. For more Account Setup Wizard
information, see Scheduling
automatic backups in Chapter 5,

fBackups. o
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Tools menu continued...

Account
Setup
Wizard

Remote

Management

Health
Check

Snapshot >
Export
Backup
Snapshot

Snapshot >
Import
Restore

Snapshot

Launch the Account Setup Wizard, which
enables you to change the Backup Account
settings. For more information, see Account

SetupWizasrdinChapter 3, @A«

Access theRemote Management

Settings dialog box. Using the settings
available, you can enableRemote
Management of the Client via the SP
Console.For more information, see Remote
ManagementinChapt er 8,ndf Ojp

settings.o

Access theHealth Check dialog box.
Performing a Health Check enables you to
highlight possible issues. For more
information, see Health Check in Chapter 8,
AfOptions amd settings

Accessthe Export Backup Snapshot

dialog box, which enables you to configure
the next backup to bea Snapshotbackup to a
specific location. For more information, see
Backup SnapshotsinChapt er 8,
and settings.0

Accessthe Import  Backup Snapshot
dialog box, which enables you toconfigure
Restore Snapshot settings. For more
information, see Restore Snapshofsin

Chapter 8, fAOptdons a

[Tu:u:uls Help

Add Metwork: Volume
Additional Backup Seks »
Automatic Backups
Account Setup \Wizard

Remoke Management

el LoD 22U = arod

Rernoke Management
Health Check. ..
Snapshak 3
Plug-ins 3
Opkions

HCCOUND 2eldp wiZgard

Remoke Management
Health Check. ..
Snapshot 3
Plug-ins 3
Options

Export Backup Snapshot

Import Restare Snapshok

Export Backup Snapshot

Import Restore Snapshok
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7ools menu continued...

Plug -ins > Access theEmail Notification settings 3 Ernail Makification
Email dialog box, which you can useto
Notification enable/disable Email notification and

configure its settings. For more information,
seeEmail Notification plug-in in Chapter 9,
iPl-iumgs . O

Options Opens the Options and Settings  dialog
e

box that enables you to modify a range of
. . . . Cptions
Client settings. For more information, see

Chapter 8, @fAOpt.ibtons a

Icon Access a list of the icons IHElF'

Legend used in the Attix5 Pro Icon Legend #| T File {not selected)
Client and their & Included by user
meanings Product Help @& Included by user Filker

About AthixS Pro SE | @ Excluded by user
& Excluded by user filker
€3

Excluded by administrat:

Trrhided by arafilina

Product Access the Product Help. @
Help

Help
About Access the product ['m
Attix5 Pro information and support Icon Legend 3
contact details.
Product Help
Abouk AbkixS Pro SE
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Tabs
There are three tabsavailable in the Backup Client:

Backup Selection : This tab displays the files and folders on the computer, enabling
you to select the items to be backed up For more information , see Selecting data to
backupi n Chapter 5, fABackups. 0

Restore: Use this tab to browse previous backups and restore files and folders.

Logs: Use this tab to view detailed information on each backup and restore.

)
)

Tip: In the right -hand pane on the Backup Selection and Restore tabs, you can click
any of the column headings to sort the list according to their values.

i Backup Selection | +J Restare | = L'I";IS|
: I Filename
- |~ $Recycle.Bin
b~ $Recycle.Bin |~ Config.Msi
|~ Config.Msi |~ MsoCache
[+f = M30Cache |~ PerfLogs
"L—:- Perflogs [~ Program Files
[l Program Files [~ ProgramData
--L_'. ProgramDiata |~ Recovery
"L—:- Recovery |~ Swskern Yolurme InFarmation
EHL - System Volume Inf | | = Users
[hh - Users L Windows
G- Windows ) autoexec.bat
- System State Plug-in || & config.sys
T hiberfil.sys
) pagefile.svs
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Product Help

@ You can acess theBackup Client Help by clicking Product Help  on the Help menu.

| Alternatively, click the Help button on the toolbar.
Help

As you navigate the Client, the Help pane will display information relevant to the selectedtab.

@ Product Help @ Product Help
_ *
= Im o .
Quick-start R Yol can reskare Files andfar Falders in
Skep-bry-skep guide three steps:
Backups: How to... 1. Select data ko restore
Select data 2, Start the restore process
Use selection filkers 3. gelect the restore options
Export a seleckion repork
Back up manually .
Selecting data to restore
Schedule aukomatic backups g
Rest  How t ou can kell the Backup Client which
estores: How L0... files andfor Folders to restore and
Restore files and Folders _ _ o 4
Find particular Files to restore which to ignore by clicking the |
Restore the backup seleckion Restore tab and then including or
- excluding the items as described -

Status bar

This area displays the date and time of the last backup performed by thesystem.

Ready Last backup:Jan 18, 2010 2:55:31 PM
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System tray icon

The System tray icon [E] indicates the backup activity status and can be used to perform various

tasks.
o An animated icon indicates that the service is busy with a backup process.
Open
Right-click the system tray Backup Mow
icon to view the menu options Cancel Backup
available .

hanitor Status

v Motify on Success Muatifications »
v Motify on Failures About
v Motify an Warnings

Bzt

Note: On the Windows 7 operating system, the system tray icon is hidden by default. To

display the icon, click the Show hidden icons  arrow, click Customize . In the dialog
box that appears, expand the Behaviours drop-down next to SERunner.exe , and
then selectShow icon and notifications

System tray menu

Open

Backup Now

Cancel
Backup

Opens the Attix5 Pro Client application window.

\U) Tip: Users can also doubleclick the system tray icon to open the
application window. For more information, seefi Appl i cati o
earlier in this chapter.

Manually initiate s the backup process without opening the Backup Client
application window.

If the service is busy with a backup (when the E‘ icon is animated), Cancel will
stop the process.
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System tray menu continued...

Monit Il
onitor Opens a smal T TeoIer =
Status window above the Attiz5 Pro SE
system tray Lazt Backup: Today 3:00 PM Success
displaying the Meut Backup: Today 700 P
progress of the

current process.
This enables you tomonitor the status and progress of the task being performed
without opening the application window.

Notifications Provides you with options to enable/disable backup notifications. For more
informati on, see ANotificationso | ater
About Displays a window containing the

edition and version details. Click
anywhere in the window to close it.

ATTIX’Pro

Server Edition V6

Exit Removesthe [E] icon from the system tray.

;} Note: This will not stop the Attix5 Pro service from running scheduled
backups.

To see the icon in the system tray again, simply open theAttix5 Pro Client interface
using the Windows Start but t on . For more informatio
Clienti nt er faceo earlier in this chapter.

v Warning:  The Backup Service must be running at all times for backups (manual or
scheduled) to take place.

i) | Note: To stop or start the Backup Service, open Administrative Tools in the Control
Panel , and then double-click Services . In the list of services that appear, select Attix5
Pro SE and selectStop or Start on the toolbar. A red crosswill appear in the corner of

the system try icon when the service is not running : .
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Notifications

The system tray icon can display a number of naotifications once a backup has completed. The
following notifications are available:

Backup successful (popup message displayed for 5 seconds)

Backup successful with errors (message displayed for one minute)

Backup failed (message displayed until you click it) text

When a notification is available, a pop-up will display information. If there were warnings or
errors, the system tray icon will also flash a red cross.

@ Attix5 Pro SE mes A\ Attix5 Pro SE XX
Backup completed successfully. Backup completed successfully but there were warnings
and/or errors, please view backup log for more details.

i) | Note: To view related log file information, click anywhere within the pop  -up.

To disable notifications

Notifications are enabled by default but you can disable them individually by right -clicking the
system tray icon and then clearing the check mark next to the relevant Notifications  option.

Open
Backup Mow
Cancel Backup

hdanitor Status

Motify on Success Motifications L
v Motify on Failures Shout
v Motify on Warnings
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After installing Attix5 Pro Server Edition (SE) and creating a Backup Account you can tell the

Backup Client which files and/or folders to back up and which to ignore by creating a backup

selection ( s e e 0 @ datagocktadkm p 06 b eYlow ean then start a backup manually or

schedule automatic backups ( see HfAPer f or miakmkuao mandaliSbhedul ing a
backupsodo bel ow) .

i) Any changes, additions or deletions to included files and folders will be backed up
intelligently with every manual or scheduled backup.

The following sections describe how to:

Selectdata to back up

Usefilters to specify files and/or folders to be excluded from the backup selection.
Determine the backup selection size

Start backups (automatically and manually)

Cancel a backup

Resume a failedor cancelled backup

You can make your first backup selection or modify a backup selection at any time using the
Backup Selection tab as described below.

To select files and folders for backup:

1. Click the Backup Selection tab.

2. In the Backup Selection tree, navigate to the folder or directory containing the file or
folder.

3. Include or exclude files and/or folders, as described below.

Once a file or folder is included in the backup selection, any modifications to it will
be backed up automatically. For more information, see Patching inChapt er 8,
and settings.o

1, | Warning:  If you have limited space on the drive running the Backup Client, itis
recommended that you move the Cache,Logs and Temporary folders as well as the
selection database to another location. For more information, see Disk Usage in
Chapter 8, AOptbdbons and Settings.
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To include an individual file:

In the right -hand pane, click the file icon ' or right -click the file name, and then click Include .
An included file is displayed with a green icon: ©

To deselect a file, you can either click the icon againor right -click the file name, and then
click Deselect . A folder containing some included files is displayed with a green tinted icon:
&

To include an entire folder:

Right-click the folder icon -, and then click Include Folder . Alternatively, you can select the
folder in the Backup Selection tree, and then click Include Folder on the Selection menu.
Included folders are displayed with a green icon: £,

i) All files in the included folder and its subfolders wil | be included in the next
backup. Any changes made within this folder or its subfolders will automatically be
included as well.

To deselect a folder,right -click the folder icon, and then click Deselect Folder

To exclude a file or subfolder:

If an entire folder is included but you wish to exclude a particular file or subfolder, right-click
the file or folder icon,and then click Exclude or Exclude Folder . Excluded items are
displayed with red icons: & or ¥ Included folders that have some files or sibfolders excluded
are green with a red tint: £

You can create different backup selections for different backup sets. For more
information, see Multiple Backup SetsinCh apt er 8, Sef@ipgs.i ™ n s
You can usefilters to automate file selection based on file types.

Once you have selected all files to be included and excluded, it may be useful to
check the size of your backup selectionbefore initiating your first backup. For
more information, see Using filters later in this chapter.

Some files and directories are forcefully excluded from the backup selection. On
Windows machines, these are the pagefile.sys and hiberfil.sys files; and the Backup
Client cache and to backup folders.
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You can use filters to automate file inclusions or exclusions within a folder, based on file types.

x A *.doc filter will include or exclude all Word documents within a folder, as
well as any new Word documents that are added to that folder later.

To apply a predefined filter to a specific folder:

1. Inthe Backup Selection tree, right -click the folder icon.

2. Point to Filters .

3. Point to one of the available filters in the list (e.g. MS Office documents ).
4. Click Include or Exclude .

To modify an existing filter

1. In the Backup Selection tree, right-click the folder icon, point to Filters , and then
click Edit filters

2. Select one of the filters andthen modify its properties in the Edit filter  box.

3. Click OK.

To add a new filter from within the Edit filters  dialog box, click the New button, supply
a name that describes the filter, enter the file type(s), and then click OK.

To add a new filter  via the Backup Selection tree:
1. Right-click the folder icon, and then click New filter
2. Inthe Filter name box, type a name to be used in the Filters menu
3. Inthe Filter box, specify the file extensionsto which the filter will apply.
4. Click OK.

The filter will be added to the Filters menu and you will be able to use it to include or exclude all
files matching its criteria.

To remove filters from a folder:

1. Right-click the folder icon.

2. Pointto Filters .

3. Point to the name of the filter you wish to remove.

4. Clear the check mark next to the selection (nclude or Exclude ).

To identify files and folders selected by filters:

Look at the icon state. Files and folders included in the backup selection by filters display with
icons containing blue check marks: & and (e
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Some inclusions and exclusions are enforced at administration level on the Storage Platform.
This is called i p r o foi.Fori o information, see Profiing in Chapt er 8, AOptions
settings. 0

Files and folders affected by profiling display with the following icons :

File inclusion

[~ Filtered file inclusion
File exclusion
Folder inclusion

¥ Filtered folder inclusion

Folder exclusion

Profiled selections cannot be modified from within the Backup Client and can only be
changed on the Storage Platform. For more information, please refer to the Attix5 Pro
Storage Platform Console User Manua |.

Global filters enable you to specify files and/or folders to be excluded from the backup selection
They also enable you to specify which file typesshould not be compressed before backup.

To add Global Filters

1. Click the Options button on the toolbar , and then click Global Filters

2. Select the type(s) of filters to apply and then specify their values.(For more information,
seeGlobal Filters i nChapt er 8, AOpt.ibg)hs and settings

3. Click OK.
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Icon legend

On the Backup Selection tab, each file and folder is displayed with an associated icon The

colour of the icon indicatest he f il e or f ol der6s backup selection s
ﬂ Backup Selection | i Restore I g L'I";IS|
il My Computer ' ] Filenarne 5~
B3 C L ‘Windows Sidebar
e $Recycle.Bin [ ¥ Windows Partable Devices
L: onfig.Msi [ ¥ ‘Windows Photo Yiewer
B-Lwf MS0Cache [ wWindows NT
&S PerfLogs &7 Windows Media Plaver
xR AP rogram Files (¥ Windows Mai
L: ProgramData [ ¥ Windows Journal

The following icon legend lists the Attix5 Pro icons and the statuses they indicate. You can
access this legend byclicking Icon Legend on the Help menu.

Note: For more information on backup selections (i ncl usi ons and Seedaticgl
dat a t o darbecikthisichapter.

Icon legend

C File (not selected) The file exists in the folder or directory but is not included in

i)
e

the backup selection (neither included nor excluded) .

[ Selected by user The Backup Clientuser hasincluded the file in the backup
selection.

g Selected by user filter The Backup Clientuser has applied a filter to the parent folder
or directory. That filter has included the file in the backup
selection.

[=] Excluded by user The Backup Client user hasexcluded the file from being

backed up to the Storage Platform.

[ %] Excluded by administrator The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform.

= Included by profiling The Backup or Storage Platform Administrator has included
this file or file type. Files displaying this icon will be backed up
to the Storage Platform and cannot be deselected from within
the Backup Client.
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Included by profiling filter

Excluded by profiling

Folder (not selected)

Some files selected by user

All files selected by user

All files selected by user,
some excluded

All files excluded by the
user

Filter applied by user

Filter applied by user,
some excluded

All files included by
profiling

Filter applied by profiling

Filter applied by profiling ,
all items excluded

ATTIX’

The Backup or Storage Platform Administrator has applied a
filter to the parent folder or directory. That filter has included
the file in the backup selection. Files displaying this icon
cannot be deselectedor excluded from within the Backup
Client.

The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform and cannot beincluded in
the backup selectionfrom within the Backup Client.

The folder exists in the directory but it is not included in the
backup selection.

The Backup Clientuser hasincluded some filesin the backup
selection.

The Backup Clientuser hasincluded all files in the backup
selection.

The folder contains no unselected files. Each file is either
included or excluded.

The Backup Clientuser hasexcluded all files in the folder from
being backed up to the Storage Platform.

The Backup Clientuser has applied a filter to the folder. The
filter has included one or more files within the folder.

The Backup Clientuser has applied a filter to the folder that
hasincluded and excluded files within it.

The Backup Administrator hasincluded all the files contained
in the folder. All files will be backed up to the Storage
Platform. Theseinclusions cannot be changed by the Backup
Client user.

The Backup Administrator has applied a filter to the folder.
This filter cannot be removed by a Backup Clientuser.

The Backup Administrator has applied a filter to the folder,
resulting in the folder being excluded from the backup
selection. This filter cannot be removed by a Backup Client

user.
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Filter applied by profiling,
some items included by
user

Filter applied by profiling,
some items included and
some items excluded by
user.

Filter applied by profiling
but items excluded by

user.

Folder excluded by Global
Filter.

All files excluded by
profiling

Plug-in node (not

selected)

Some items selected by
user

All items selected by user
All items selected by user,
some excluded

All items excluded by user

Filter applied by user

The Backup Administrator has applied a filter to this folder
using profiling and some items have beenmanually included
by the Backup Client user (seefiSelecting data to back um
earlier in this chapter).

The Backup Administrator has applied a filter to this folder
using profiling . Some items have beenexcluded and others
included by the Backup Client user (seefiSelecting data to back
upoearlier in this chapter).

Items in the folder have beenincluded using filters (seefUsing
filters O earlier in this chapter.)

The folder has beenexcluded using Global Filters.

The Backup Administrator has excluded all files in the folder.
Theseexcluded files cannot be included by a Backup Client

user.

The plug-in exists but is not selected for backup to the Storage
Platform.

The Backup Clientuser has selected some of the items in the
plug-in for backup to the Storage Platform.

The Backup Clientuser has selected all items in the plugin for
backup to the Storage Platform.

The Backup Client user hasincluded and excluded items in the
plug-in.

The Backup Clientuser hasexcluded all items in the plug-in
from being backed up to the Storage Platform.

The Backup Clientuser has applied a filter to the plug-in;

specifying that certain file types must be included for backup
to the Storage Platform.
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lcon legend menu continued...

ﬁ Filter applied by user, The Backup Clientuser has applied a filter to the plug-in;
some excluded specifying that certain file types be included for backup to the
Storage Platform but some items have beenexcluded either
through the use of an exclusion filter or by manual exclusion.

i) | Note: For more information, see Profiled selectonsi n Chapter 4, fGrap
(GUNDO and-inPhGlgapter -9ns Al ug
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It is useful to determine the backup selection size before starting the backup process to avoid

Over Limit errors.

i) The Backup Client compares your backup selection size with the Backup Account

| limit (specified by your Backup Administrator) at the beginning of the backup process. If
the selection size exceeds the Account limit,the backup process will stop and an Over
Limit error message will be displayed.

To calculate the backup selection  size:

A. On the File menu, click Calculate Size.
B. Alternatively, click the Size button on the toolbar :

EEEEL

Backup Size Restors Find Options  Autornate Help

The Backup Selection  Size dialog box that appears displays total size of your backup
selection (i.e. all files included for backup).

Backup set index prepared in < 1=
Files and directories: 1 Total size: 24 bytes
Mandatory files: 0 Takal size; 0 bykes

/v | Wamning  s:

A If your backup selection size exceeds your Account limit, you need to remove some
items from the selection or ask your Backup Administrator to upgrade your
Account limit.

A If a backup fails and an Out of Memory error messageis recorded in the backup
log, you need to increase the default amount of server memory you wish to allocate

to the backup service.

To remove a file from the backup selection
A. In the Size dialog box, right-c | i ¢ k t h e ©fThd ied will turnc ead to indicate
that it is excluded: &.

To exclude multiple files at once, click a file name in the list, hold down the
Shift key and drag the mouse pointer to highlight the files. Right -click the
selection, and then click Exclude .
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B. Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are
currently selected for backup. For more information, see Selecting data to back up in
Chapter 5, ABackups. 0

After creating a backup selection, you can exporta list of all backup inclusions and exclusions to
an html file for future reference.

The selection report will specify:
Files and folders included in the backup
Files and folders excluded from the backup
How eachitem was selected (userselected, filters, profiling or mandatory patching)
Where each item is located on the machine
The total number of items in the backup selection

To export a selection report:

1. Onthe File menu, click Export Selection
2. Inthe Save As dialog box, select the location in which to save the file, type a file name
in the File name box, and then click Export

The file will be saved to the specified location and can be viewed in any Internet browser.

& Ci\Users\User\Docurments\Backup selection.html - Windows Internet Explarer =R =
[P |g C\Users\User\Dacurnents\B v‘41»|,\ Hb Bing o -

i Favorites | 9 @ Suggested Sites = @] Web Slice Gallery +

»

& Cillsers\User\Documents\Backu... fi - B v =) v Pagev Safetyr Toolv @~

AS5BP Backup Set as on 19 Jan 2010 05:53 PM

Backup Account: BACKUP ACCOUNT 01

Backup Group: A-5P OWNER\RESELLER \BACKUR ACCOUNTS
Storage Platform: 192.168.20.215

Backup Set Name: Default

Backup Set Version: 6.0

Client Version: 6.0.0.685

m

Schedule

Daily backups for this backup set occur at 11h04

Mo advanced schedule is defined.

Selections

Overview

There is 1 volume with selections:

o O
o 1 folder directly included
o 1 folder directly excuded
o 1 file directly included

fa v ®0% -
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It is recommended that you run a backup manually after creating your backup selection
to ensure immediate data transmission to the Storage Platform . Thereafter, automatic backups
will ensure hassle-free continuous backups. For more informat i o n, see fASche
b a ¢ k Uapesimthis chapter .

To star ta backup manually :
1. Onthe File menu, click Backup Now . Alternatively, click the Backup button on the
toolbar.

o

Backup

The Backup dialog box appears and displays the progress of the backup:

-

|E| Backup @

| Preparing backup

Connecting ko service
Skarting backup
Initializing secure random generatar, ..

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue
will display in the Backup dialog box, enabling you to cancel the current backup in
favour of the next, should you wish to do so. For more information, see Multiple Backup
SetsinChapter 8, AOpt.ibons and settings

2. To close the Backup dient after the backup process has started, click theHide button.
This will not cancel the backup process and the Backup Client can b re-opened at any
time to view the progress of the backup.

You can monitor the backup progress at any time by right -clicking the system tray icon
and then clicking Monitor Progress
To view backup logs, click the Logs tab. Backup log dates are displayed in blue.
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Automatic backups are usually enabled and configured during the Account Setup process (see
Step 5 of 8: Schedule Backup Processin Chapter 3 , iAccount yoSeah enpblepnd b u t
schedule them at any point in time using the Options and Settings  dialog box.

To schedule daily automatic backups

1. On the Tools menu, click Options . Alternatively, click the Options button on the
toolbar.

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the correct set is selected in the
Backup Set drop-down box. (For more information on backup sets, see Multiple
Backup SetsinChapter 8, AOpt.)dbons and settings

4. Select the Daily Automatic Backups check box and then specify a backup time in
the Back up every day at  box.
5. Click OK.

To schedule advanced backups:

1. Onthe Tools menu, click Options .

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the correct set is selected in the Backup
Set drop-down box. (For more information on backup sets, see Multiple Backup Sets in
Chapter8,i Opti ons anod settings

Select theAdvanced Schedule  check box.

In the Week Day box, select a day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule box.
Repeat steps5 to 7 above until you have added all desired schedules to theAdditional
Schedule box.

© N o oA

You are advised to back up at night when the server running the Backup Client is
not in use. It must be switched on at the scheduled backup time(s), but the
Windows user does not need to be logged in.

Configuring automatic backups ensures that all selected data is backed up
automatically, without the need for any user interaction. This is a safer
alternative to relying on manual backups.
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Backups will initiate at the scheduled times and the Backup dialog box will appear displaying
the progress of the backup

|E| Backup

| Sending backup

Connecting ko service

Skarting backup

Initializing secure random generator. ..

Connecking bo Storage Plakform on 192,168.20.215:4473
Server name: Storage Platform, AkkixS Dey OA,

Building selection lisk

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue will
display in the Backup dialog box, enabling you to cancelthe current backup in favour of the
next, should you wish to do so. For more informatio n, seeMultiple Backup Sets in Chapter 8,
AiOptions andd settings

To close the Backup Clientafter the backup process has started, click the Hide button.
This will not cancel the backup process andyou can re-open the Backup Client at any
time to view the progress of the backup.

You can monitor the backup progress at any time by right -clicking the system tray icon
and then clicking Monitor Progress

To view backup logs, dick the Logs tab. Backup log dates are displayed in blue.

| B Backup Selectiunl 2 Eestnre| =| Logs
19 Jan 2010, 18:46:46 t15:46:46 Tue, 19
19 Jan 2010, 15:44:22 essage) 1846046 05 Win

19 1an 2010, 15:35:45 | essage: 18:46:46 Using ba
essage; 15146046 Connect

Backups will be stored on the Storage Platform and accessible via theRestore tab. For more
information on restoring data, see Chapter 6, fARest
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Cancelling a backup

Once a backup is in progress, you can cancel the process via the Backup progress window or
using the system tray icon.

To cancel a backup:

1. Perform one of the following actions:
a) Inthe Backup progress window, click the Cancel button.

IE' Backup @

| Sending backup

Connecking ko service

Starking backup

Building selection list

Tatal selection: 570 bytes in 2 files and folders

Starking Y33 snapshat

Checking for differences

Total backup size: 171 bytes

Iritializing secure randor generakar., .

Connecting ko Skorage Platform on 192,165, 20, 245443
Server name: Storage Plakform, AktixS Dev O,

| Server name: Storage Plakform, Atkixs Dey Q4,

[ Cancel *[ Hide ]

b) Alternatively, you can right -click the runner icon in your system tray, and then click
Cancel .

Open

Backup Mow
Cancel Backup
Monitor Status

Motifications r

Abhout

2. Inthe confirmation dialog box that appears, click Yes.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. If, however, the previous backup was not successfuland a
manual backup is initiated, the Backup Client will display the prompt: Do you want to
resume the failed backup ... ?0with a 30 second countdown.

-

Canfirm resurme backup @

Do you want to resume the failed backup from Tue 19 Jan 2010, 18:51:507
(A new backup will stark in 28 seconds)

| Yes || Mi || Cancel |

Click Yes to instruct the Backup Client to try to continue from where the process failed during
the previous backup. Click No to initiate a new backup or Cancel to return to the Backup Client
application window.

You can only resume a backup if the backup completed the Processing stage.
A new backup will be initiated automatically after the countdown has elapsed.
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On the Restore tab, you can browse a tree structure representation of all successful backups
and their files and folders.

The following sections describe how to select data to restore, start the restore process, and
search for specific backed up files.

On the Restore tab, the Restore tree gives you access tdacked up files via two main nodes:
Last Backup and Previous Backups

The Last Backup node contains the file/folder
structure of the last successful backupand displays

EM the date and time it occurred in parenthesesfi (. ) 0
[ =4 Last Backup (19 Jan 2010, 18:52:25]!|

- C
L e Warkspace
| =4 _ Previous Backups |

‘e Backup Selection | & Restore | =] Lags

i) Restores done from the Last
Backup node are typically faster than
those done from the Previous Backups

19 Jan 2010, 114427

19 an 2010, 11:43:08 backups from the Storage Platform and displays

them in the tree.

+-]_ 19 Jan 2010, 18:51:40 .

+:t 19 Jan 2|:|an 18:51:17 node as the Backup Client may be able to
- oo retrieve the data from the cache instead

+-) 19 Jan 2010, 18:46:16 the Storage Platform

+-) 19 Jan 2010, 18:38:15 9 '

+-) 19 Jan 2010, 17:40:25

#0019 Jan 2010, 1713953 When you expand the Previous Backups node,

- 19 Jan 2010, 11:44:55 the Backup Client retrieves the list of previous

+...L_

+...L_

To select and restore data  from the

1. Click the Restore tab.

2. Expand the Last Backup node to view the files/folders.

3. Include a single file by clicking the ' icon next to the file or by right-clicking the file
name and then clicking Include . Eachincluded file is displayed with a green icon: ¥

4. Include an entire folder by right-clicking the folder and then clicking Include folder .
Eachincluded folder is displayed with a green folder icon: L.

5. If an entire folder is included but you wish to exclude a particular file or

subfolder, right -click the file or folder icon, and then click Exclude or Exclude
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Folder . Excluded items are displayed with red icons: & or £¥. Included folders that
have some files or subfolders excluded are green with a red tint: £=.

Once all the files and folders to be restored are selectedstart the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on the restore options available, seefiRestoringdatad | at er i n t

To select and restore data from

Click the Restore tab.

Expand the Previous Backups node to connect to the Storage Platform and retrieve a
list of all previous backup dates.

Expand the relevant backup node, and then click the folder/directory containing the
data.

Include a single file by clicking the T icon next to the file or by right-clicking the file
name and then clicking Include . Each included file is displayed with a green icon:
Include an entire folder by right-clicking the folder and then clicking Include folder .
Each included folder is displayed with a green folder icon: L=

If an entire folder is included but you wish to exclude a particular file or
subfolder, right -click the file or folder icon, and then click Exclude or Exclude
Folder . Excluded items are displayed with red icons: & or £, Included folders that
have some files or subfolders excluded are green with a red tint: £

Once all the files and folders to be restored are selected, start the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on t he r es Restorimgdatpdtbalowns avai l

hi

abl

S

e

c ha

S
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After you have selected the files and folders to restore, you canstart the restore process as
described below.

To start the restore process.:

1. On the File menu, click Restore . Alternatively, click the Restore button on the

toolbar:
[t i
ARG
Backup Size | Restare Find | Options  Autornate  Help

The Restore dialog box will prompt you for a restore location :

Save files in:

Criginal location

@ Folder: |[CHiUsers\UseriRestore Browse

2. SelectOriginal location  to restore the files to the same location that they were backed
up from or selectFolder and then browse to a new location.

v. | Warning: If Original location is selected the restored files will overwrite
any existing files with the same name in that location. A warning will, however,
be displayed before the Backup Client overwrites any files.

In the Options area, specify the restore options.

Options
| Recreate directory skructure
| Restore empty Folders
Crvepwrite Files
| Use compression (Faster over the Internet)
| Restore file and folder permissions

Restore directly bo target location (Faster, but resume on File level not possible)

For more information on restore options, see the

3. Click OK.
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Restore options

Recreate directory

structure

Restore empty folders

Overwrite files

Use compression

Restore file and folder

permissions

By default, the folder structure is recreated in the Restore
folder. To specify that all files be restored to one location, clear
the Recreate folder structure check box

i) | Note: If restoring files from different folders with the
same file names, you need to recreate thedirectory
structure to prevent overwriting the files.

To restore all empty folders within the directory structure,
select the Restore empty folders  check box Clear the
check box to restore only those folders containing backed up
files.

l/ Note: This option is only available when Recreate
directory structure is selected.

Selectthis option to prevent the Backup Client displaying a
prompt before overwriting existing file s.

&
",

/¥ | Warning:  If this check box is selected, files with

matching filenames in matching directories will be
overwritten without warning.

Select theUse compression  check boxto enable the Storage
Platform to compress files beforetransmitting them to the
Backup Client.

\J Tip: You are advised to enable this setting when
restoring over a slow Internet connection as it will
reduce the size of the files, making the transfer
process faster.

Clear this check box to prevent the Backup Clientrestoring file
and folder permissions. You would typically only select this
option after a complete server failure (to restore files before
user accounts are re-created).

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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Restore options continued...

Restore directly to target

location

Select this check box to write files directly to the specified
folder without using a temporary working folder. The restore
process is faster using this option due to less disk access.
However, a file-level restore resume is not possible. $iould
there be acommunication error during a file transfer, the
complete file will be resent.

1}) Note: You can view restore logs on the Logs tab. Restore log dates are displayed in

green.

|| ﬂ Backup Seleckion | ﬂ Restore I§—| Logs

19 Jan 2010, 13:46:46
19 Jan 2010, 134422

essage: 15:46:46 Tue, 19
essage: 15460146 05 Win
Message: 15:46:46 Using ba
Message: 15:46:46 Connect

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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To find a specific backed up file, it may be easier to use theFind function than to browse the
Restore tree.

You have the option to scan only your last backup (locally), or you can connect to the Storage
Platform and searchthrough previous backups.

To search for afilein  your latest backup:

1. On the File menu, click Find Files in Backups . Alternatively, click the Find button
on the toolbar:

L1990 e w

Backup Size Restors Find Options  Autornate Help

2. Type the file name or part thereof in the File name box, and then click Find .

File name {Full or partial): sales|

@ Search last backup (local)

) Search through previous backups (Storage PlakForm)

Search backup dates

[ Limit number of results to; |10

Find

= If fealesdis searched for, the Backup Client will display a list of all files in the
| ast backupsaedsntiai hhegfil ename.

Use the* and ? wildcards for advanced search queries.
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To search for a file in previous backups:

1. On the File menu, click Find Files in Backups . Alternatively, click the Find button
on the toolbar:

AN OO

Backup Size Restore Find Optiens  Autornate Help

2. Type the file name or part thereof in the File name box.

3. Select theSearch through previous backup s (Storage Platform ) check box.

4. If you wish to limit the search to particular dates, select the Search backup dates
check boxand then use the Start date and End date boxes to specify a time period.

5. To limit the number of results that display, select the Limit number of results to
check box and thentype anumber in the box provided.

6. Click Find .

File name (full or partial); | sales

1 Search last backop (local)

@ Search through previous backups (Storage Platform)

Search backup dates

Skart date: |01-01-2010 lEJ rAP-dd-ey
End date: |01-19-2010 lEJ Pr-dd- 4

Limit nurnber of resulks kod |10

"

Use the* and ? wildcards for advanced search queries.

i) If Search backup dates is selected the backup date is used for the search
instead of the file create or file modified date.
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To restore files from the Find Files in Backup dialog box:
1.

In the search results list, include the files to restore by clicking the icons next to the file

names or by right-clicking each file name and then clicking Include

2. Click the Restore button.

File name (full or partial); | sales

@ Search last backup (local)

1 Search through previous backups (Starage Plakform)

Search backup dates

[ Limit number of results to: |10

Search result

Find

_ | Falder | Filename |5 | Date _|_Fi... _|_E=an:k... |
& Ch\Users\Bashier. .. salesMow2009, Ext OKE 19/01/20... kxk 19/01)20...
© iC\Users\Bashier... salesanz010.bxt  OKB 19/01/20... kxt  19/01/20...
) Ci\Users\Bashier. .. salesDec2009, bxt OKE 19/01/20... kxk 19/01)20...

The Restore Options

the restored fil

es. For mor e i
this chapter.

nf ormati on on

Restnrﬁ

dialog box will appear, enabling you to specify the location in which to save

restore

C



Restoring a backup selection

By default, with every backup performed, a copy of the backup selectionis saved on the Storage
Platform . For more information on backup selection, see fiSelecting data to back up earlier in

this chapter.

This enables you to restore, not only your backed up files and folders,but the selection you used

to back them up as well.

i) | Note: This is especially useful in disaster recovery cases, as it enables you to restore
your entire backup setup to perform exactly as it did at the last backup.

To restore a backup selection

1.

Click the Restore tab.

2. Expand the relevant backup folder, and then click the Workspace node.

3.

The backup selectionwill be restored to the location specified in the restore options.

| il Backup 53Iectinn| ol Restore | = Lu:ugsl

i Backups
El--’.___'. Lask Backup (19 Jan 2010, 19:12:50)

In the right -hand pane, click the icon next to the name of the backupset toinclude it for
restore. If you have not enabled Multiple Backup Sets (see Multiple Backup Sets in
Chapter 8, i Op tdi)o, n si nacnl du dseethathiisplayssn | y

Filenarne

O Include
& Excld
1 Deselect

Click the Restore button on the toolbar .

Select the appropriate restore options. ( Se e

chapter.)
Click OK.

nSel

ecti

ng
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Attix5 Pro allows Backup Administrators to archive Backup Clientsé data to t ape
drive using the Hierarchical Storage Management (HSM) feature. Once data has been archived,
the backups will display in the Restore tree as greyed out folders, allowing you to browse the
file/folder structure of the backups. However, if you try to restore archived data, you may

receive a message informing you that the data has been archived to secwlary storage, as

illustrated in the screenshot below.

il Backup Selection i Restors I E| Lu:ugsl

il Backups Filenarme %~
EI--I.__.. Last Backup (3 Aug 2010, 12:50:

Ehia G 0 booktmgr
-4~ Program Files ) BOOTSECT.BAK
L WSS Wiriters 0 MSDOS,SYS
o Woarkspace

Ié|"‘|_... Prewious Backups
| 03 Aug 2010, 12:21:54
B4 23 1 2010, 15:56:25 . ©=
EH . 23 Jul 2010, 16:01:01 o This data has been archived to secondary storage
...... | |
¥ and removwed from the Storage Platform. To restore any of these Files,

please contact your backup administrator and request
to have the files moved back to the Storage Platform.

[+ S Wiriters -
o] Workspace

i) Grey folders indicate archived data. However, if you do not see these folders in
the Restore tree, it does not mean that no archived backups are available. In such
cases, pease consult your Backup Administrator for further details about archived

backups.

You can access archived data by requesting that your Backup Administratorimport the HSM
data to the Storage Platform. Once the data has been imported, it will be available for restore in
the same manner as all other backups.

or

anof
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The Backup Clientlogs all backup and restore processes and their results in log files thatyou can
view on the Logs tab. The following sections describe how to access log filesand modify their

settings.

The Logs tab in the Backup Client provides detailed information about each backup and
restore. An additional toolbar button appears when the Logs tab is opened: the Summary

button. Use the button to view only errors and warnings and the last 14 lines in the log file.

i

[Ea] 2t Pra SE W6.0.0

Eile Selection Tools Help

Backup Size

Restore

A0 D0@O@

Find

Cwptions  Autornate  Help

| & Backup Selection | = Eestu:urel =| Logs

19 Jan 2010,

19 Jan 2010, 18:52:23 Errars and warnings

19 Jan 2010, 18:52:11

13 Jan 2010, 18:51:43 Lask few lines of log File

19 Jan 2010, 15:46:46

19 Jan 2010, 184422 Message: 19:12:55 -—mmmmememmmemeeeee Technical Data ---------

19 Jan 2010, 15:35:45 Message: 19:12:53 Backup prepared in; 00:00;01

19 Jan 2010, 18:38:35 Message: 19:12:53 Mew files: 3; 16.3 KB {comp: 0.2 KB)

19 Jan 2010, 18:11:34 Message: 19:12:53 Remwed.ﬂles: 0; 0.0KE

19 Jan 2010, 17:40:55 Message: 19:12:53 F‘a_tu:heu:l flles: 1;0SEKE+0.2KE--=0,

Message: 19:12:53 Skipped files: O

13 Jan 2010, 17:40:22 Message: 19:12:53 Disk usage drive C: 31% Full, 12,42 GBS

19 Jan 2010, 11:45:23 Message: 19:12:53 Cache using 434 bytes (< 1% of disk sp

19 1an 2010, 11:44:55 Message: 19:12:53 Temp dir using 2.0 KB (< 1% of disk sps

19 Jan 2010, 11:43:56 Message: 1912153 ----------mmmmmmmee Drata Transmitked ------

19 Jan 2010, 11:40:42 Message: 19:12:53 Mo MNeed to transmit: 0.0 KB

19 Jan 2010, 11:40:29 Message: 19:12:53 Transm?tted during n:n:nmpres.sin:nn: ] .

19 Jan 2010, 11:04:04 Message: 19:12:53 Transmitted after compression: 2.0 KB i
_ Message; 1911253 ========== Backup Summary ===

13 Jan 2010, 11:03:24 1= Message: 19:12:53 Total selection: 1.4 KB in 11 files and fo

19 Jan 2010, 11;02:03 Message: 19:12:53 Tokal backup time: &5

19 1an 2010, 11:01:03 Message: 19:12:53 Backup Skatus: Successful

19 Jan 2010, 09:35:00

" You can use theUp arrow , Down arrow , Page Up , Page Down , Home

End keys to navigate the log.

and
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You can specify your logging preferences on the Logging pagein the Options and Settings
dialog box.

Modifiable settings include :
level of detail included
date inclusion/exclusion in time stamp
log file retention period

For information on configuring the log file settings, see Logging in Chapt er 8, AOptions
settings. 0
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To access the Options and Settings dialog box

On the Tools menu, click Options . x
Alternatively, click the Options button on the toolbar :

Backup Cize

©© @

Restore Find Options | Autornate  Help

The various options and settings are grouped in the left-hand pane according to their functions.
Click an item on the left to view the full set of options related to that function.

=

Click Advanced Options in the left-hand pane to view all advanced options

on the right:

E Options and Settings

) Account and Security Advanced Options

) Connections

1 Backup Schedule Cammunications

1 Backup Throttle

) Display [7] Complete compression/patching before sending data to the Storage Platform.

) Disk Usage

 Performance and Limits Werify account limit before compression/patching.

: gl\:tlz:::gwlters Use secure (55L-enabled) conr!ectmn for data transfer (Recommended). )
Warning: This should only be disabled to enhance transfer speeds after the network has been confirmed to be secure.

1 Mandatory Patching

" Logging

" Advanced Options Biackup Process

Enable volume Shadow Copying (¥55) to back up locked Files.

[] Use 55 to update the cache.
Using this option will increase the speed of the cache update process, It will however also increase the load on YSS and may cause VS5 to Fail on
servers with heavy 10 (like file servers), resulting in cache update Failures,

[] Use MTFS Change Journal for supported volumes

Retries and Timeouts

Mumber of Backup/Restore attempts before cancelling: jl 04
Duration between connection retries (seconds): il )

Socket timeout {seconds): jl 60

Warning:  The Options and Settings dialog box controls advanced features in the
Backup Client. Please read through this section carefully before changing any settings.
Incorrect settings could cause critical errors.

You can use the Account and Security page in théptions and Settings  dialog box to:
Update Account information
Change your password encryption key or Backup Account properties
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Modify Client security settings

Options and Settings

Advanced Options

[= i )
nccount.and et Account and Security

) Connections
) Backup Schedule Account Information
) Backup Throttle
1 Display Backup Account: BACKUP ACCOUNT 01
) Disk Usage Backup Group: A-5P OWHERIRESELLER ABACKIUP ACCOUNTS
) Performance and Limits Starage Platform: 192.168.20.215
" Global Filkers Waur current account limik is: 512 ME
) Patching
) Mandatory Patching Click on Retriewe Settings to connect ko the
 Loggi Storage Platfarm and retrieve the account settings. Reliicycgelines

qaing
=

Account Setup

From this section, wou can change your password or encrvplion key and run the Setup Wizard,
should you want to create a new account or reconneck o an existing one,

Change Password ] l Change Encryption Key ] l Run Setup Wizard

Security Settings

Specify whether the Backup Client should remember the Backup Account password during the backup
or restore procedures,

(@ Remember password for backup and restore
() Prompt for password an restore

-~ Prampt For password to apen the Backup Client and ta restare. (If you Forget the password
= wou will hawe to reinstall the client)

ik ][ Zancel ][ Help
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The Account and Security page consists of the followingareas:
Account Information
Account Setup
Security Settings

This area displays your Backup Accountinformation as it is configured on the Storage Platform .
You can use theRetrieve Settings button to update your Account settings.

This button is useful to verify that the Account limit has been modified after
requesting a change from the Backup Administrator or to update Backup Group
Profiling settings.

You can use theChange Password and Change Encryption Key buttons to overwrite the
current password and encryption key. To change your Backup Account settings, click the Run
Setup Wizard button. For more information, see Account Setup Wizard in Chapter 3,
fiAccount setup. O

1, | Warning s:

A Changing the encryption key involves intensive processing on the Storage Platform
and may take several minutes. You should avoid doing this unless the encryption
key has been compromised.

A Disaster recovery is not possible without t he encryption key. Please ensure that
this key is kept in a safe place. THIS ENCRYPTION KEY IS NOT STORED ON THE
STORAGE PLATFORM AND CANNOT BE RECOVERED OR RESET IF LOST.

In the Security Settings area,you can select whether or not the Backup Client should remember
the Backup Account password when running a backup or a restore.

There are three options available:

Remember password  for backup and restore : The Backup Client remembers the
Backup Account password when doing a backup or restore. This is the default setting.
Prompt for password on restore : The Backup Client prompts for the Backup

Account password during the restore process.

Prompt for password to open the Backup Client and to restore : The Backup
Client prompts for the Backup Account password when opening the Backup Client and
the Restore tab.
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Connections

You can use theConnections page in the Options and Settings  dialog box to:
Modify Storage Platform connection settings
Enable/disable/configure proxy server details

Options and Settings @
| = i =
- Connections
) Backup Schedule Connection Settings
) Backup Throttle
) Display Use this section to change your connection settings, These settings were configured in the Setup
) Disk Usage Wizard during the installation process.
) Performance and Limits (@ Use network connection
1 Global Filters
1 Patching () Use dial-up connection
) Mandatory Patching - -
© Logging Dial-up 3ettings. ..
=

Advanced Options

Proxy Server

If vou use & proxy server For yvour Inkernet connection, you will probably have to supply the same
proxy server infarmation in the Backup Client,

@ Mo procy

() Use HTTP proxy

() Use SOCKSYS Proxy

Proxy Hosk: Procey Port: (10050

Proocy server requires aukhentication

Usernarme:

Password;

ik ][ Zancel ][ Help
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The Connections pageconsists of the following areas:
Connection Settings
Proxy Server

In this area, you can change the type of connection that the Backup Clientuses to connect to the
Storage Platform. You can choose between a networlor dial-up connection.

i) The Dial -up Settings button is enabled if you select Use dial -up connection
Click this button to select an existing dial -up connection configured on the computer and
then supply the username and password for that Internet connection.

In this area, you can specify whether or not the Backup Clientshould connect to a proxy server
when connecting to the Internet. If you select that it sho uld, you can specify the proxy server
details in the relevant boxes.
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Backup S chedule

You can use theBackup Schedulepage in the Options and Settings  dialog box to:
Enable/disable daily automatic backups
Create advancedautomatic backup schedules

Options and Settings @
1 Account and Security Backup Schedule
) Connections : — i
) Backup Schedule r .

) Backup Thrattle Barkup Set: Default ~ ch 38 [

—~

D!splay Automatic Backups

) Disk Usage

" Perfarmance and Linits Daily automatic backups

) Global Filkers

) Patching Back up every day at: :l 11ho4 @

) Mandatory Patching

) Logging [7] advanced schedule

) Advanced Options Back up at the Following tirmes

Week Day Additional Schedule
Mu:nnddav Backup time:
Tuesday
12h00 @

Wednesday :‘
Thursday add
Friday
Saturday Delete
Sunday

ik ][ Zancel ][ Help
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The Backup Schedulepage consists of theAutomatic Backups area.

i) If using Multiple Backup Sets, use the Backup Set drop-down at the top of the
dialog box to specify which backup set schedule you wish to configure. For more
information, see Multiple Backup Setsin Chapt er 8, fAOptbons an

In this area, you can enable or disable automatic backups

Daily automatic backups are enabled by default unless disabled during the
Backup Account setup. If disabled, you can enable it by following the
instructions below.

To enable automatic backups :
1. Select theDaily automatic backups check box.
2. Specify a time in the Backup every day at  box
3. Click Ok.

To disable automatic backups (not recommended):
1. Clear the Daily automatic backups and Advanced Schedule check boxes.

2. Click Ok to close the Options and Settings  dialog box.

v | Warning:  This option is not recommended. If an automated backup scheduleis not
created, backups will have to be run manually . Enabling automatic backups is
strongly advised .

For detailed instructions on how to enable and schedule automatic backups seeScheduling
automatic backupsi n Chapter 5, fABackups. o
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Backup Throttle

The Backup Throttle pagein the Options and Settings  dialog box enables you to specify the
Client's bandwidth usage speed limits. You can do this by creating a backup throttle map.
Backup data will then only be transferred at the specified speed limits durin g each interval.

Options and Settings -H

) Account and Security Backup Throttle

) Connections : i

) Backup Schedule Speed Limits

E‘ Bgckup Uiiie Specify one or more speed limits (in kilobytes per second) that can be used when sending backup data
Display ko the server, & limit of O indicates that no limit will be applied.

) Disk Usage

1 Performance and Limits . Lirmik 1: ol= kefs . Lirmiit 2+ 0/ keys

) Global Filkers = -

O Patching B it = ofskeis [ it 4: o2 keys

) Mandatary Patching Limit 5: 0l kBls . Lirniit 62 012 kBfs

) Logging

) Advanced Options Throttle Map

Selected speed limit:
(Click to cycle)

Interval: 60 | minutes

1 3 5 7 9 11 13 15 17 19 21 23
MMonday
Tuesday
Wednesday

Thursday
Friday
Saturday
Sunday

l Clear ” Defaulk

Ok ” Cancel H Help
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The Backup Throttle page consists of the following areas:
Speed Limits
Throttle Map

In this area, you can specify one or more speed limits (in kilobytes per second) that can be
applied when sending backup data to the server.

To specify a speed limit:
Choose a colour to represent the limit and specify the limitint hat clonitohox. 6 s
You can now schedule the speed limits in the Throttle Map area as described below.

i) A limit of O indicates that no limit will be applied.

In this area, you can indicate when the speed limits specified in the Speed Limits area should
apply by creating a throttle map.

By default, a throttle map is provided with different colours indicating week day
office hours, out-of-office hours and weekends (using intervals of 60 minutes) . You can
either set speed limits for the colours used in this default map or you can click
the Clear button and create a new map by following the instructions below .

To create a throttle map

1. Inthe Interval box, specify the number of minutes that each block in the graph should
represent.

2. Inthe Speed Limits area, click a speed limit colour.

3. Inthe Throttle Map area, click the schedule interval boxes you wish to apply the limit to.
The colour of the selected interval boxeswill change to match that of the chosen limit.
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Display

You can use theDisplay page in the Options and Settings dialog box to select your Backup
Client display preferences.

Options and Settings @

il SEcurity
Displa
) Connections play

Backup Schedule Selection Table
Backup Throttle
' Display [ Display File Type column in selection table.
Disk Usage
Performance and Limits Display folders in selection table,
Global Filkers
Patching
Mandatory Pakching
Logging
Advanced Options

sllalolallalalal  [aXe]

ik ][ Zancel ][ Help
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The Display page consists of a Selection Table area that provides you with the following options:

Display File Type column in selection table - Adds aFile Type column to the
right -hand pane of the Backup Selection and Restore tabs.
Display folders in selection table - Enables the Backup Selection t ab&s- ri ght

hand pane to display subfolders.
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You can use theDisk Usagepage in the Options and Settings  dialog box to:
Move the working folders and cacheto a different location
Specify the number of days that files are to be kept in the cache

Options and Settings

Account and Secority
Connections

=3

Disk Usage

) Backup Schedule
" Backup Throttle

Display

" Disk Usage
Performance and Limits
) Global Filkers

Patching
Mandatary Patching
Logging

Advanced Options

Waorking Folders

¥ou can move the Cache, Log, Temporary Folders and the Selection Database ko another location if
there is limited space available on the drive where the Backup Client is installed.

Moke: Ahways keep these folders on the same drivevolume,

Temp: C:\Program Files\attixS Pro\Backup Client SE\toBackup Browse. ..
Cache; Ci\Program Files\AttixS ProtBackup Client SE'cache Browse, .,
Logs: C:\Program Files\attixS Pro\Backup Client SEllogs Browse. ..

Dakabase: C:\Program Filesiattizs ProtBackup Client SE Browse, .,

Cache

Changed files are compared to the previous version ka anly transmit patches. The longer files are
kept in the cache, the better the chance of transmitting patches instead of Full copies,

Davs to keep files in Cache: :l 20 Clear Cache. ..

Ok ” Cancel H Help
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The Disk Usage page consists of the following areas:
Working Folders
Cache

If you have limited space on the drive running the Backup Client, you can move
the Cache, Logs and Temporary folders as well as the selection database to another location.

The following locations are configurable in this area:

Temp - Used as temporary workspace when the files are patched, compressed and
encrypted.
Cache - Keeps a local, compressed and encrypted, copy of the selected files for a
specified number of days.
Logs - Stores all backup and restore logs.
Database - Compares the latest backup selection with the previous backup to
determine the changes.

" Wgrning S:
A The Cache and Temp folders must reside on the same drive/volume.
A If the database or any of the folders are stored on a network share, please ensure

that the Backup Service has the correct permissions to connect and write to that
share.

When modifications are made to a file, the Backup Client only transmits changes to that file, as
opposed to transmitting the complete file again. This is accomplished by the use of a local cache

By default, recently modified files are kept in the Cache for 20 days, after which they will be
deleted. Once a file has been flushed from the cache, a full copy will be backed up when any
modifications are made to the file. The longer files are kept in the Cache, the better the chance of
only transmitting patches instead of full copies and thus reducing the amount of data that needs
to be transmitted. If there is limited disk space available, consider shortening the time files are
kept in the cache.

i) If you specify 0 days for caching, patching is disabled. All files in the Cache will
be deleted, andfull copies of changed files will be transmitted to the server during each
backup.

To delete the current cache use the Clear Cache button. If the cache is deleted, full copies of
the selected files will be re-sent to the Storage Platform during the next backup.

i) The Backup Client will log the message Doing monthly cache cleanup once a
month. This maintenance task is to ensure that there are no redundant files in the Cache.
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You can use thePerformance and Limits page in the Options and Settings
Enable/disable the Run backups in

dialog box to:
the background

or increase/decrease Backup Clientprocessorand disk usage(Windows Server 2003)
Set data transfer limits

Ensure that a certain amount of free spaceis always available on the hard drive during

data dumps, patching or compression

Options and Settings

[l

Advanced Options

r i _
Accaunt and Security Performance and Limits
) Connections
1 Backup Schedule Processor Usage & Disk Access
1 Backup Throttle
) Display If wou experience any performance dekerioration during the backup process, you can lessen this
) Disk Usage effect by choosing ko run the backup in the background, which lowers the disk and CPU usage
 Performance and Limits ety o et
) Global Filkers
) Patching [7] run backups in the background
) Mandatory Patching
) Logging
=

Lirnits
This section allows you ko manipulate the data transfer during the backup process if vou have ka limit

the transfer in any way.

[ restrict size of each backup (ME): :‘ 10

Cvcle backup process until all selected data has been transferred. The backup process
will be repeated until the complete backup has been kransferred to the Storage Plakform,

Free Space

Ensure that the Backup Client does not use all available hard drive space during data dumps,
patching or compression,

[ Enforce free space (GE): :‘ i0

option (Windows Server 2008)

Ok H Cancel H Help
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The Performance and Limits page consists of the following areas:
Processor Usage & Disk Access
Limits
Free Space

The Backup Client uses a fair portion of available processor power to patch, compress and
encrypt files during the backup process. If you use the computer at the same time, you may
experience some performance deterioration. To lessen thiseffect, you canchoose to run backups
in the background on Windows Server 2008 machines or lower the processor usageand/or disk
accesson Windows Server 2003 machines.

Windows Server 2008

On Windows Server 2008 machines, a Run backups in the background check box enables
you to instruct the Client to run all ba ckups in the background, thereby lowering the disk and
CPU usage priority in Windows and allowing other applications to run faster .

i) The Run backups in the background check box isdeselectal by default.

Windows Server 2003

On Windows Server 2003 machines, two sliders enable you to adjust the processor usage and
disk access settings to limit performance deterioration.

Processar Usage: [ J
Low High
Disk Access: |_J
Liow High

v | Warning:  If you use the highest Processor Usage setting, it will affect server
performance during the backup.

i) If you use theHigh Disk Access setting, the Backup Client will continuously use

| all available disk access to read and write to the disk, ensuring that the process
completes as quickly as possible. The process will take longer if this setting is lowered
but other disk -intensive applications will perform better.
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Select the Restrict size of each backup (MB) check box and specify a maximum value to
limit the total am ount of data that may be transmitted to the Storage Platform during each
backup.

If this option is enabled, it may take several backups before all files are
transmitted to the Storage Platform. This feature is especially useful when using a slow
Internet connection and ther e are problems with transmitting large backups.

Cycle backup process... 1 You can use this setting in conjunction with the backup size
restriction to cycle backups successively until all dataincluded in the backup selection has been
transmitted to the Storage Platform. This setting is only available if a backup size restriction has
been specified.

To ensure that the Backup Clientdoes not use all available hard drive space during data dumps,
patching or compression, you can select theEnforce fr ee space check box, and then specify
the maximum amount of disk space the Client will be allowed to use.
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You can use theGlobal Filters page in the Options and Settings  dialog box to:
Exclude files globally
Exclude folders globally
Set up a No Compression Hiter

Options and Settings

1 Account and Security

X5

Global Filters

) Connections
™ Backup Scheduls Exchude Files
-
= B..acklup Thratte ‘o can specify file extensions that must be excluded From the selection list at all times, Files can also
- D!SE ay b excluded according to their modified date,
Disk LIsag8 o Mote: Swstem exclusion filkers are marked with a different icon in the Backup Client and cannok be

) Performance and Limits selected for backup.
= Global Filkers
) Patching [T Exclude these files:
) Mandatory Patching
€ Logging Examples:
) Advanced Opions file?,doc

video®  *

*.mp3

specific, avi

[7] Do not back up files older than: i, dd-mm-yyyy )

Exchude Folders

Specify Folders that should be excluded From the backup selection, no matter where they are located
on the available drives or volumes, Note: no wild cards or path separatars are allowed.

[ Exclude these Folders:
Examples:

Ty Music
Data
Photas

Mo Compression Filker
¥ou can specify file extensions For which no compression will be used. This is a global setting.

Do nok compress these file types:  |*.zip;*.cabg* gz ™. bz * rpm; . jpg; * rar . 72 % aif ;% . png

ik ][ Zancel ][ Help
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The Global Filters pagein the Options and Settings  dialog box consists of the following areas:
Exclude Files
Exclude Folders
No Compression Filter

In this area, you can specify that files with certain file names, extensions or last modified dates
be excludedfrom all backups.

To exclude files based on  their file name s or extension s:
1. Select theExclude these files check box.
2. Type the file name(s) and/or file extension(s) in the box provided; separated by
semicolons or listed beneath each other.

v You can use wildcards. E.g. *.mp3 will exclude all MP3 files from backups.

= To exclude all MP3 and AVI files, specify *.mp3 and *.avi in the text
box. Separate entries with a semicolon or type each on a new line.
3. Click OK.
To exclude files based on their 'last modified' date s:
1. Select theDo not back up files older than check box.
2. Inthe box provided, type the date in dd-mm-yyyy format.
3. Click OK.

In this area, you can exclude certain folders from all backups.

To exclude folders:
1. Select theExclude these folders  check box.
2. Type the folder names in the box provided; separated by semicolons or listed on
separate lines.
i)

Wildcards and path separators are not supported in this area.
Entries are case sensitive.

3. Click OK.
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In this area, you can specify the file types that the Backup Client should not compress during the
backup process.

v Compression is not effective on all file types as some files may already be
compressed or cannot be compressed at all. The Backup Client could spend some time
and processing usage trying to compress these files. You can use ths filter to specify a
list of file extensions that the Client should not attempt to compress during the backup

process. The list of file types already specified are types that typically do not compress
well.

To exclude files from compression:

1. Select theDo not compress these file types check box.

2. Type the file extensions in the box provided, separated by semicolons.
3. Click OK.
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You can use thePatching page in the Options and Settings

dialog box to:

Enable/disable Delta Blocking
Enable Binary Patching limits

-~

Options and Settings

Account and Secority

=3

Patching

Advanced Options

) Connections

) Backup Schedule Delta Blacking

" Backup Throttle

1 Display Delta Blocking is Faster than Binary Patching and does not need a complete copy of the file in the
) Disk Usage cache. It will however create larger patches and therefore use more disk space on the Storage
) Performance and Limits Platform.

1 Global Filkers [] Enable Delta Blocking For:

" Patching

) Mandatory Patching Files larger than 1.0 GE

) Logging o (gither condition)

=

(@ and (both conditions)

Files with these extensions:

Binary Patching Threshaold

3ome data files can change significantly from one backup to the next, resulting in large, inefficient
patch files, Setting a patch abort threshold enables wou to abort such a patch and transmit the
complete file bo the Storage Plakform inskead, saving processing time.

[7] Enable patching limits

abort threshold: 1.0 GB

Moke: This option is useful for databases that are re-organized periodically and cause the backup
window ko be exceeded,

Ok ” Cancel H Help




ATTIX’

The Patching pagein the Options and Settings  dialog box consists of the following areas:
Delta Blocking
Binary Patching Threshold

Delta Blocking is an alternative to Binary Patching and compares changes on a block level. Itis
significantly faster than Binary Pat ching and does not require a complete copy of a file in the
Cacheto calculate the patch, only a footprint file. The footprint file requires very little free disk
space - 0,0006% of the original file. However, Delta Blockin g patches are much larger than
Binary patches.

i) Pleaseread through this section before enabling this option in the Backup Client.

To enable Delta Blocking

1. Select theEnable Delta Blocking  for check box.

2. The Delta Blocking file selection criteria can be set in two ways: by file size or file type.
Select the applicable condition(s) and supply the necessary information. Any recently
changed files not matching these criteria will be patched using Binary Patching.

1. | Warning:  Some database files may not be suitable for Delta Blocking since data is
shifted at the beginning of the file. When this happens, it will result in a patch as large
as the complete file. It is advisable to closely monitor the sizes of the patches when Delta
Blocking is enabled and disable it if it turns out to be ineffective.

Binary Patching is the most effective form of patching. It is CPU-intensive but will deliver the
smallest patches. The process is only possible if a complete copy of an older version of thelé is
available in the Cache

i) Binary Patching is enabled by default and nothing needs to be configured on this
tab for normal use.

Enabling patching  limits : It is possible that a file could be modified in such a way that it
becomes impractical to patch it. An example would be a database that is reindexed.

In such a case, the patchingcan take extremely long (it may exceed the backup windav) and will
eventually create a patch that is the same size as the complete file. Itwould be better to abort
the patching and compress the new file instead. The patching limit indicates when patching will
be aborted and the complete file compressed and esent to the Storage Platforminstead.
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To specify patching  limits:

1. Select theEnable patching limits check box.

2. Inthe Abort threshold  box, specify the abort threshold (in gigabytes).

When this limit is reached, patching will be aborted and the complete file will be
compressed and resent to the Storage Platform.

Patching limits should only be enabled if you have severe patching problems with
large files.



ATTIX’

Mandatory Patching

You can use theMandatory Patching page in the Options and Settings  dialog box to instruct
the Backup Client to scan certain files, regardless of whether or not they appear to havwe changed
since the last backup (ie.eveni f t he f il eds time)stamp remains the

v Tip: This is useful in situations where files are held open by an application (internally
the file changed, but the change is not reflected in the last modified date on the file
system or in the size of the file itself).

Options and Settings @

- i .
'qmunt,and security Mandatory Patching
) Connections

Backup Schedule The Following Files will be scanned For changes regardless of whether
Backup Throtte they appeat to have changed since the last backop.

Display
Disk Usage
Performance and Limits
Global Filkers
Patching
' Mandatory Pakching
Logging
Advanced Options

MNAEEIDIDODDNDO O
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Files selected for mandatory patching display on the Backup Selection tab with a green icon
containing t™e | etter AMO:

To select files for mandatory patching
1. Click the Add button.
2. In the Open dialog box that appears, navigate to and select the file(s) and then click
Open . The file(s) location(s) will display in the Mandatory Patching list.
3. Click OK to saveyour settings.

Select more than one file at a time by holding down the SHIFT key and selecting
the files with your keyboard or mouse.



































































































